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Safety warning notice

A WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a
hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact
the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer and the AC
adapter comply with the user-accessible surface temperature limits defined by the International Standard
for Safety of Information Technology Equipment (IEC 60950).
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Product description

Category

Description

Product Name

HP Pavilion HDX Entertainment Notebook PC

Processors

Intel® Core™ 2 Extreme processors (4-MB L2 cache, 800-MHz front side bus
(FSB), 44-W):

X7900 2.8-GHz processor

X7800 2.6-GHz processor

Intel® Core™ Duo processors (4-MB L2 cache, 800-MHz FSB, 35-W):

T7700 2.4-GHz processor

T7500 2.2-GHz processor

T7300 2.0-GHz processor

T7100 1.8-GHz processor

System design supports up to 55-W requirement

Chipset

Northbridge: Intel PM965

Southbridge: ICH8m

Graphics

ATI Discrete PCl Express x 16 Graphics via MXM

Panels

20.1-inch WSXGA UltraBrightView (1680 x 1050), ~300 nits typical brightness

Memory

2 SODIMM slots

Customer-accessible/upgradable

PC2-5300, 667-MHz, DDR2

Dual-channel support

Supports up to 4096 MB of system memory
e  4096-MB total system memory (2048 MB x 2)
e 2048-MB total system memory (1024 MB x 2)

e 1024-MB total system memory (512 MB x 2)

Hard drives

Supports all Serial ATA (SATA) 9.5-mm, 2.5-inch hard drives

RAID software support not required for second hard drive




Category Description

Dual hard drive configurations:

e  400-GB, 4200-rpm (200 GB x 2)

o 320GB, 5400-pm (160 GB x 2)

e  280-GB, 5400-rpm (160 GB + 120 GB)
e  240-GB, 5400-rpm (120 GB + 120 MB)

e  200-GB, 7200-rpm (100 GB x 2)

Optical drives 12.7-mm tray load

Parallel ATA

Fixed (1 screw for removal)

Support for the following optical drives:

e  DVDzRW and CD-RW Super Multi Double-Llayer Combo Drive with LightScribe

e  HD-DVD Drive (with read-only function)

Camera Low-light VGA camera

Tilt: +/- 15 degrees, with activity LED

640 x 480 by 30 frames per second

Diskette drive Supports external USB drive only

Audio HD audio: SigmaTel STAC9271D5TAyy

10-channel, simultaneous Voice over IP (VolP) output (V.7.1), with 95-dB signalto-noise ratio

(SNR)

Dolby home theater support

12-band parametric equalizer (disabled when external connections are made)

Dynamic processing for tunable compression/limiter function

Speakers requirements:

4 speakers (40 mm x 20 mm x 10 mm dimensions)

2 speaker enclosures on the display panel, each with a 30-cc chamber

40-mm subwoofer located in base enclosure with 110-cc chamber, mechanically isolated from
the computer with soft elastomeric grommets and foam

V. 7.1 analog out and supported ports

Supports Microsoft Premium requirements

Pavilion-branded Altec Lansing speakers

2 omnidirectional microphones

Modem No integrated modem
Ethernet Intel 10/100/1000 Gigabit Ethernet network interface card (NIC)
Wireless Integrated wireless local area network (WLAN) options by way of wireless module:
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Category

Description

Intel PRO wireless 4965 a/b/g with 2 WLAN antennae built into the display assembly +
Bluetooth®

Intel PRO wireless 4965 a/b/g/n with 3 WLAN antennae built into the display assembly +
Bluetooth

Intel PRO wireless 3945 a/b/g with 2 WLAN antennae built into the display assembly +
Bluetooth

Integrated TV tuner options

Integrated NTSC/ATSC hybrid TV tuner (in Canada and the United States)

Integrated analog/DVB-T TV tuner (in the rest of the world)

PAL to F-jack and infrared emitter with cable, included with TV tuner option

TV tuner antennas for both DVB-T and ATSC/NTSC

External media card

One ExpressCard 54 slot, supports hybrid analog+ATSC and DVB-T TV tuner

Digital Media Slot: supports SD, MMC, SD 1/O, MS, MSP, xD-Picture Card; with adapter,
supports mini versions of SD, MMC, and MS Duo (adapter is not included)

Ports

Video poris:

VGA (Dsub 15-pin) supporting 1920 x 1200 external resolution @ 75 Hz, hot plug/unplug,
and auto-detect for correct output to wide-aspect video (disabled when connected to the HP
xb3000 Notebook Expansion Base and HP Notebook QuickDock)

High-definition multimedia interface (HDMI) V. 1.2 supporting 1080p with High-bandwidth
Digital Content Protection (HDCP) key

Audio ports:

Analog audio-out V.7.1

Audio-in (stereo microphone)

Audio-out (stereo headphone, 2 ports)

Center low-frequency effect (LFE) output

Front, rear, and side speaker outputs

Consumer infrared

TV tuner ports:

Stereo audio input

RF input using PAL jack

S-Video capture input

Infrared emitter jack

Other ports:

AC power through 180-W Multipin AC adapter plug (Smart AC adapter)

Consumer infrared

eSATA

IEEE 13%94a

RJ-45 (Ethernet, includes link and activity lights)




4

Category

Description

S-Video-out (including composite video support) via docking only

USB (4)

Remote control

The remote control is docked into the keyboard deck. The remote control can be ejected by
pressing the remote control eject button. The remote control can also be locked onto the
computer.

Software codes for all keys follow Microsofit® Media Center requirements.

The remote control battery is customer-accessible/upgradable.

Remote control weight:
e Without batteries: 41.5 to 46.5 grams

e  With batteries: 45.0 to 50.0 grams

Remote control buttons:

e MS Start (MCE green)
e Numeric keypad (0 - 9)
e Clear

o  Enter

e  Channel up/down

e  Volume up/down

e  Fast forward

e  Reverse

e  Play/pause

e  Previous/next track

e OK

e  Back

e  Mute

e Guide

e DVD player

e TV (in the United States)/Teletext (in Europe, the Middle East, and Africa)

e QuickPlay launch

e  Record
o Information
e Power

e Music (in the United States)/R (in Europe, the Middle East, and Africa)

e  Photos (in the United States)/G (in Europe, the Middle East, and Africa)
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Category Description

e Video (in the United States)/Y (in Europe, the Middle East, and Africa)

e  Zoom (in the United States)/B (in Europe, the Middle East, and Africa)

Docking Expansion port 3 supports the HP xb3000 Notebook Expansion Base and HP Notebook
QuickDock (does not support power via dock)

Keyboard/pointing devices 14.39-inch fullsize keyboard with separate numeric keypad

Touchpad supports 2-way scrolling

Taps enabled as default

Power requirements 9-cell 2.55-Ah, 83-Wh Li-ion battery

180-W non-PFC AC adapter with localized cable plug support (multiwire plug with ground
pin, supports 2-pin DC connector)

Security Security cable slot

Fingerprint reader with VeriSoft software support

Operating system Preinstalled:

Windows Vista® Ultimate (64-bit)

Windows Vista Premium (32-bit)

Serviceability End-user replaceable parts:

AC adapter

Battery (system)

Hard drives (2)

Memory module

Optical drive

WILAN module




2 External component identification

Top components

Display and top components

Item Component Description
(1) Speakers (4) Produce sound.
(2) Internal microphones (2) (select models only) Record sound.

NOTE: If there is a microphone icon next to each
microphone opening, the computer has internal
microphones.

(3) HP Webcam light On: The integrated camera is in use.

(4) HP Webcam Records video and captures still photographs.
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Item Component

Description

(5) HP Webcam rotator

Tilts the camera vertically.

(6) Internal display switch

Turns off the display if the display is closed while the computer
is on.

Top-left buttons and lights

Item Component Description
(1) Power button* e When the computer is off, press the button to turn on the
computer.
e When the computer is on, press the button to initiate
Sleep.
o When the computer is in the Sleep state, press the button
briefly to exit Sleep.
e When the computer is in Hibernation, press the button
briefly to exit Hibernation.
If the computer has stopped responding and Windows®
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the computer.
To learn more about your power settings, select Start >
Control Panel > System and Maintenance > Power
Options.
(2) Power light e On: The computer is on.
e  Blinking: The computer is in the Sleep state.
e  Off: The computer is off or in Hibernation.
(3) Media button e  Opens the QuickPlay program (for models with

QuickPlay preinstalled).

e Opens the DVDPlay program (for models with DVDPlay
preinstalled).

Top components 7



8

Item Component Description
NOTE: If the computer has been set up to require a logon
password, you may be asked to log on to Windows.
QuickPlay or DVDPlay opens after you log on. Refer to the
QuickPlay or DVDPlay software Help for more information.
(4) DVD button Opens the DVD playback feature of the QuickPlay program.
NOTE: If the computer has been set up to require a logon
password, you may be asked to log on to Windows.
QuickPlay opens after you log on. Refer to the QuickPlay
software Help for more information.
(5) TV play button Opens the TV module within the QuickPlay program.
(6) Previous/rewind button e  Plays the previous track or chapter when the button is
pressed once.
e  Rewinds media when the button is pressed
simultaneously with the fn key.
(7) Stop button Stops playback.
(8) Play/pause button Plays or pauses media.
(9) Next/fast forward button e  Plays the next track or chapter when the button is
pressed once.
e  Fast forwards media when the button is pressed
simultaneously with the fn key.
eater mode button ims the lights on the computer.
10 Th de b Dims the ligh h p
(11) Remote control button Ejects the remote control.
aps lock light n: Caps lock is on.
(12)  Caps lock ligh On: Caps lock |

*This table describes factory settings. For information about changing factory settings, refer to the user guides located in Help
and Support.
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Top-right buttons, lights, and fingerprint reader

Item

Component

Function

m

Fingerprint reader

Allows a fingerprint logon to Windows, instead of a
password logon.

(2)

Wireless button

Turns the wireless feature on or off, but does not create a
wireless connection.

NOTE: To establish a wireless connection, a wireless
network must already be set up.

(3)

Wireless light

e  Blue: All integrated wireless devices, such as WLAN
devices and/or Bluetooth® devices, are turned on.

e Amber: All integrated wireless devices are turned off.

(4)

Volume mute button

Mutes and restores speaker sound.

(5)

Volume mute light

e  Blue: Computer sound is turned on.

e Amber: Computer sound is turned off.

(6)

Volume down light

Blinking: The volume scroll zone is being used fo decrease
speaker volume.

7)

Volume scroll zone

Adjusts speaker volume. Slide your finger to the left to
decrease volume and to the right to increase volume. You can
also tap the minus sign on the scroll zone to decrease volume,
or tap the plus sign on the scroll zone to increase volume.

(8)

Volume up light

Blinking: The volume scroll zone is being used fo increase
speaker volume.

9

Treble or bass volume down light (select models only)

Blinking: The volume scroll zone is being used to decrease
treble or bass volume.

(10)

Treble or bass volume scroll zone (select models only)

Adjusts treble or bass volume. Slide your finger to the left to
decrease volume and to the right to increase volume. You can
also tap the minus sign on the scroll zone to decrease volume,
or tap the plus sign on the scroll zone to increase volume.

(1)

Treble or bass volume up light (select models only)

Blinking: The volume scroll zone is being used to increase
treble or bass volume.

(12)

Optical drive button

Releases the media tray.

(13)

Optical drive light

Blinking: The optical drive is being accessed.
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Item

Component

Function

(14)

Treble light (select models only)

On: The treble volume function is on.

(15)

Bass light (select models only)

On: The bass volume function is on.

(16)

Treble/bass button (select models only)

Alternates between treble and bass volume controls.

(17)

Num lock light

On: Num lock is on or the embedded numeric keypad is

enabled.

TouchPad

Item

Component

Function

m

TouchPad light

e  Blue: TouchPad is enabled.

e  Amber: TouchPad is disabled.

(2)

TouchPad*

Moves the pointer and selects or activates items on the screen.

3)

Left TouchPad button*

Functions like the left button on an external mouse.

4

TouchPad on/off button

Enables/disables the TouchPad.

(5)

TouchPad scroll zone*

Scrolls up or down.

(6)

Right TouchPad button*

Functions like the right button on an external mouse.

*This table describes factory settings. View or change pointing device preferences by selecting Start > Control Panel >
Hardware and Sound > Mouse.
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Item Component Description

(1) esc key Displays system information when pressed in combination
with the fn key.

(2) Function keys Execute frequently used system functions when pressed in
combination with the fn key.

(3) Integrated numeric keypad keys Can be used like the keys on an external numeric keypad.

(4) fn key Executes frequently used system functions when pressed in
combination with a function key or the fn key.

(5) Windows logo key Displays the Windows Start menu.

(6) Windows applications key Displays a shortcut menu for items beneath the pointer.

Keys 11



Front components

Item Component Function
(1) Power light e  On: The computer is on.
e  Blinking: The computer is in the Sleep state.
e  Off: The computer is off or in Hibernation.
(2) Battery light e On: A battery is charging.

e  Blinking: A battery that is the only available power
source has reached a low battery level or a critical
battery level.

o  Off: If the computer is plugged into an external power
source, the light is turned off when all batteries in the
computer are fully charged. If the computer is not
plugged into an external power source, the light stays
off until the battery reaches a low battery level.

(3) Drive light Blinking: The hard drive or optical drive is being accessed.
(4) Consumer infrared lens Receives a signal from a remote control device, such as the

HP Remote Control.

(5) Audio-in (microphone) jack Connects an optional computer headset microphone, stereo
array microphone, or monaural microphone.
(6) Audio-out (headphone) jacks (2) Produce sound when connected to optional powered stereo

speakers, headphones, ear buds, a headset, or television
audio.
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Rear components

Rear left-side components

A

Item Component Description

(1) Vent Enables airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal for
the internal fan fo cycle on and off during routine operation.

(2) Infrared (IR) emitter jack Connects the computer to your cable or satellite settop box.

(3) TV audio line-in jack Connects a cable or satellite settop box to the TV tuner for
high-quality audio.

(4) S-Video-in jack Connects a cable or satellite settop box to the TV tuner for
high-quality video.

(5) RF coaxial cable jack Connects a coaxial cable or TV antenna.

NOTE: The computer is shipped with an RF coaxial cable
adapter. Depending on your computer model, the adapter
may be required for proper setup.

Rear components 13



Rear right-side components

W9y

Item Component Description

(1) Left- and rightside analog channel output jack Connects optional audio speakers for left- and right-side
audio output.

(2) Rear left- and rightside analog channel output jack Connects optional audio speakers for rear left- and right-side
audio output.

(3) Center channel and subwoofer analog channel output  Connects an optional audio speaker for center channel and

jack subwoofer audio output.

(4) Front left- and right-side analog channel output jack Connects optional audio speakers for front left- and right-side
audio output.

(5) Vent Enables airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool
infernal components and prevent overheating. It is normal for
the internal fan to cycle on and off during routine operation.

(6) Power connector Connects an AC adapter.
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Right-side components

06

Item

Component

Function

m

USB ports (2)

Connect optional USB devices.

(2)

Optical drive

Reads optical discs, and, on select models, also writes to
optical discs.

(3)

Optical drive light

Blinking: The optical drive is being accessed.

4)

Security cable slot

Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.

Right-side components 15



Left-side components

Item

Component

Function

m

USB ports (2)

Connect optional USB devices.

(2)

RJ-45 (network) jack

Connects a network cable.

3)

Expansion port 3

Connects the computer to an optional docking device or
expansion product.

NOTE: The computer has only one expansion port. The
term expansion port 3 describes the type of expansion port.

4

External monitor port

Connects an external VGA monitor or projector.

(5)

HDMI port (select models only)

Connects an optional video or audio device, such as a high-
definition television, or any compatible digital or audio
device.

(6)

eSATA port

Connects high-performance eSATA components, such as an
eSATA external hard drive.

o))

1394 port

Connects an optional IEEE 1394 or 1394a device, such as
a camcorder.

®)

Digital Media Slot light

On: A digital card is being accessed.

9

Digital Media Slot (select models only)

Supports the following optional digital card formats:
e  Memory Stick (MS)

e  Memory Stick Pro (MSP)

e  MultiMediaCard (MMC)

e  Secure Digital Input/Output (SD 1/0)

e  Secure Digital (SD) Memory Card

e  xD-Picture Card (XD)

e  xD-Picture Card (XD) Type H

e  xD-Picture Card (XD) Type M

(10)

ExpressCard slot

Supports optional ExpressCard cards.
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Bottom components

Item Component Function

(1) Hard drive bay Holds the hard drives.
NOTE: Depending on the computer model, the computer
may have 1 or 2 hard drives.

(2) Vents (5) Enable airflow to cool internal components.
NOTE: The computer fans start up automatically to cool
internal components and prevent overheating. It is normal
for the internal fans to cycle on and off during routine
operation.

(3) TV tuner module compartment Contains the TV tuner slot.

(4) Battery release latch Releases the battery from the battery bay.

(5) Subwoofer Contains the subwoofer speaker.

(6) Battery bay Holds the battery.

(7) Memory module compartment Contains the memory module slofs.

(8) Mini Card compartment (select models only) Holds a WLAN device.

NOTE: To prevent an unresponsive system and the
display of a warning message, replace with only a Mini
Card device authorized for use in the computer by the
governmental agency that regulates wireless devices in your
country. If you replace the device and then receive a
warning message, remove the device to restore computer
functionality. Then contact technical support by selecting
Start > Help and Support > Contact support.
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3 lllustrated parts catalog

Serial number location

When ordering parts or requesting information, provide the computer serial number and model number
located on the bottom of the computer.
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Computer major components




Item Description Spare part number

(1) Display assemblies (include wireless antenna transceivers and cables, camera module and cable, speakers, and
microphones and cables)

20.7-inch, WSXGA, TFT with BrightView 452299-001
20.1-inch, WUXGA, TFT 452300-001
NOTE: See Display assembly components on page 23 for more information on display assembly spare part
numbers.

(2) Rear cover 448161001

(3) Keyboards (include keyboard cable)
For use in Denmark, Finland, Norway, and Sweden 448159-DH1
For use in France 448159051
For use in French Canada 448159121
For use in Germany 448159041
For use in ltaly 448159061
For use in Latin America 448159-161
For use in the Netherlands and Europe 448159831
For use in South Korea 448159-AD1
For use in Spain 448159071
For use in the United Kingdom 448159-031
For use in the United States 448159001

(4) Top cover (includes TouchPad board cable and TouchPad button cable, and LED boards  448174-001
and cables)

(5) Audio/infrared board (includes cable) 452316001

(6) TouchPad on/off board (includes cable) 448167001

(7) Fingerprint reader board (includes cable) 448166-001

(8) Rear USB board (includes cable) 452315001
Plastics Kit 448171-001

(9a) ExpressCard slot bezel

(9b) WLAN module compartment cover

(9¢) Hard drive bay cover

(9d) TV tuner module compartment cover

(9e) Memory module compartment cover

(10) Power connector LED board (includes cable) 452318-001

(11) Audio connector board (includes cable) 452317001

(12) Video connector board (includes cable) 452321001

(13) System board (includes power connector cable, ExpressCard assembly, and 448145-001

replacement thermal material)
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Item Description Spare part number
(14) RTC battery 452319-001
(15) Front USB board (includes cable) 452314001
(16) Bluetooth module 398393-002
NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable.
The Bluetooth module cable is available in the Cable Kit, spare part number 448169-001.
(17) Video board fan 448163-001
(18) Video board heat sink (includes replacement thermal material) 448176-001
(19) nVidia video board (includes replacement thermal material) 454311001
(20) Processors
Intel Core 2 Exireme processors (4-MB L2 cache, 800-MHz FSB, 44-W):
X7900 2.8-GHz processor 453908-001
X7800 2.6-GHz processor 455738001 and
452327-001
Intel Core 2 Duo processors (4-MB L2 cache, 800-MHz FSB, 35-W):
T7700 2.4-GHz processor 448148-001
T7500 2.2-GHz processor 448147-001
T7300 2.0-GHz processor 448146-001
T7100 1.8-GHz processor 448149-001
(21) Processor heat sink (includes replacement thermal material) 448175-001
(22) Processor fan 448162001
(23) Subwoofer (includes rubber isolators) 448164-001
(24) Base enclosure (includes microphone and speaker extension cables and rubber feet)  448173-001
Rubber Feet Kit (includes 11 computer feet in 4 sizes, and rubber screw covers) 452320001
(25) Hinge cover 452311-001
(26) WLAN modules
Intel 802.11a/b/g/n WLAN modules:
e  Foruse in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, 441086-001
Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican
Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong,
India, Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia,
Taiwan, Uruguay, the United States, Venezuela, and Vietnam
e  For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, 441086-002
the Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany,
Greece, Hungary, Iceland, Ireland, Israel, ltaly, Latvia, Lebanon, Liechtenstein,
Lithuania, Luxembourg, Malta, Monaco, the Netherlands, Norway, Oman, the
Philippines, Poland, Portugal, Qatar, Romania, Russia, Serbia and Montenegro,
Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland,
Turkey, Ukraine, the United Kingdom, and Uzbekistan
e  For use in Australia, New Zealand, Pakistan, the People's Republic of China, and ~ 441086-003

South Korea
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Item Description Spare part number
Intel 802.11a/b/g WLAN modules:
e  Forusein Antigua & Barbuda, Argentina, Australia, the Bahamas, Barbados, Brunei, 452063-001
Canada, Chile, the Dominican Republic, Guam, Guatemala, Hong Kong, India,
Indonesia, Malaysia, Mexico, New Zealand, Panama, Paraguay, Saudi Arabia,
Taiwan, the United States, and Vietnam
e  Foruse in Aruba, Austria, Azerbaijan, Bahrain, Belgium, Bermuda, Brazil, Bulgaria, 452063-002
the Cayman Islands, Colombia, Croatia, Cyprus, the Czech Republic, Denmark,
Egypt, El Salvador, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, ltaly, Jordan, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg,
Malta, Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal,
Romania, Russia, Serbia and Montenegro, Singapore, Slovakia, Slovenia, South
Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey, the United Kingdom, and
Uzbekistan
e  For use in Ecuador, Haiti, Honduras, Pakistan, Peru, the People's Republic of China, 452063-003
Quatar, South Korea, Uruguay, and Venezuela
(27) Hard drives (include hard drive bracket)
250-GB, 5400-rpm 454605-001
200-GB, 4200-rpm 448155-001
160-GB, 5400-rpm 448154-001
120-GB, 7200-rpm 445152-001
120-GB, 5400-rpm 448153-001
100-GB, 7200-rpm 452313-001
(28) TV tuner modules
For use only in Europe, the Middle East, and Africa 448168-002
For use only in North America 448168001
(29) Memory modules (PC2-5300, 667-MHz, DDR2)
2048-MB 448151-001
1024-MB 448150-001
512-MB 452312-001
(30) 9-cell, 2.55-Ah, 83-Wh battery 448158-001
(31) Optical drives (include bezel and bracket)
DVD+RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe 448157001
HD-DVD Drive 448156-001
Cable Kit (not illustrated) 448169001
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Display assembly components

Item Description Spare part number

(1) Display bezel 452307-001

(2) Camera module (includes camera module brackets) 452304-001

(3) Display Bracket Kit (includes left, top, and right brackets) 452303-001

(4) Display panels
20.1-inch, WSXGA+, TFT, BrightView 452301-001
20.1-inch, WUXGA, TFT 452302-001

(5) Speaker Kit (includes left and right speakers) 452310001

(6) Display inverter 452308-001

(7) Display hinge/enclosure (includes display panel cable and wireless antenna 452306-001

cables)

Display assembly components
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Item Description Spare part number

Display Rubber Pad Kit (not illustrated) 454595001

Display Screw Kit (not illustrated) 452309-001

Plastics Kit

<

. ©

\“

Item Description Spare part number
Plastics Kit 448171-001

(1) WILAN module compartment cover (includes 1 captive screw, secured by a C-clip)

(2) ExpressCard slot bezel

(3) TV tuner module compartment cover (includes 1 captive screw, secured by a Clip)

(4) Memory module compartment cover (includes 2 captive screws, secured by Clips)

(5) Hard drive bay cover (includes 2 captive screws, secured by C-clips)
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Mass storage devices

~

Item Description Spare part number
(1) Optical drives (include bezel and bracket)
DVD+RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe 448157001
HD-DVD Drive 448156-001
(2) Hard drives (include hard drive bracket)
250-GB, 5400-rpm 454605-001
200-GB, 4200-rpm 448155-001
160-GB, 5400-rpm 448154-001
120-GB, 7200-rpm 448152001
120-GB, 5400-rpm 448153-001
100-GB, 7200-rpm 452313-001
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Miscellaneous parts

Description Spare part number
180-W PFC AC adapter 448160-001
ATSC/NTSC TV tuner antenna 439131-001
ATSC/NTSC/PAL TV tuner 439130-001
Bluetooth headset 443783001
Composite video cable 407939001
DVB-T tuner 412175-001
DVB-T antenna adapter 412176-001
ExpressCard Kit (includes software CD) 445170001
Infrared emitter with cable 439129001
Optical wired mouse 436238001

Remote controls

For use in Europe, the Middle East, and Africa 448165-002

For use in North America 448165-001

RF input adapter cable (without ferrite) 407940001

USB digital drive 364727002

Wired headset 371693-001 and
371693-003

Wireless laser mouse (includes cable adapter) 430958001

Power cords:

Australia and New Zealand 436848-011
Belgium, Europe, Finland, France, Germany, Greece, the Netherlands, Norway, Portugal, Spain, and  436848-021
Sweden

Canada, French Canada, Latin America, Thailand, and the United States 436848-001
Denmark 436848-081
India 436848-D61
Italy 436848-061
South Korea 436848-AD1
The United Kingdom and Hong Kong 436848-031
Screw Kit 448172001

e  Phillips PM3.0x12.0 screw
e  Phillips PM3.0x8.0 screw
e  Phillips PM3.0x4.0 screw

e  Phillips PM2.5%13.0 captive screw
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Description

Spare part number

Phillips PM2.5x12.0 captive screw
Phillips PM2.5x11.0 screw

Phillips PM2.5%8.0 captive screw
Phillips PM2.5x8.0 screw

Phillips PM2.5%5.0 screw

Phillips PM2.5x4.0 screw

Phillips PM2.5x3.0 broad-head screw
Black Phillips PM2.0x5.0 captive screw

Silver Phillips PM2.0x5.0 captive screw

e Black Phillips PM2.0x4.0 screw

e  Silver Phillips PM2.0x4.0 screw

e Phillips PM2.0x3.0 screw

o  Slotted SM1.5x9.0 shoulder screw

Sequential part number listing

Spare part  Description

number

371693001  Wired headset with volume control

371693003  Wired headset with volume control (glossy black)

398393-002  Bluetooth module
NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth module
cable is available in the Cable Kit, spare part number 448169-001.

413706-001  Thermal Material Kit

436848-001  2-wire power cord for use in the United States

436848-011  2-wire power cord for use in Australia

436848-021  2-wire power cord for use in Europe

436848-031  2-wire power cord for use in the United Kingdom

436848-061  2-wire power cord for use in ltaly

436848-081  2-wire power cord for use in Denmark

436848-AD1  2-wire power cord for use in South Korea

436848-D61  2-wire power cord for use in India

441086-001 Intel 802.11a/b/g/n WLAN module for use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados,

Bermuda, Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador,
El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia, Mexico, Panama,
Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United States, Venezuela, and Vietnam
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Spare part

Description

number

441086-002  Intel 802.11a/b/g/n WLAN module for use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia,
Cyprus, the Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, ltaly, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco, the
Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania, Russia, Serbia and
Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey,
Ukraine, the United Kingdom, and Uzbekistan

441086-003 Intel 802.11a/b/g/n WLAN module for use in Australia, New Zealand, Pakistan, the People's Republic of
China, and South Korea

443783-001  Bluetooth headset

448145001  System board (includes power connector cable, ExpressCard assembly, and replacement thermal material)

448146-001  Intel Core 2 Duo T7300 2.0-GHz processor (includes replacement thermal material)

448147001  Intel Core 2 Duo T7500 2.2-GHz processor (includes replacement thermal material)

448148-001  Intel Core 2 Duo T7700 2.4-GHz processor (includes replacement thermal material)

448149-001  Intel Core 2 Duo T7100 1.8-GHz processor (includes replacement thermal material)

448150-001 1024-MB memory module (PC2-5300, 667-MHz, DDR2)

448151001 2048-MB memory module (PC2-5300, 667-MHz, DDR2)

448152001 120-GB, 7200-rpm hard drive (includes hard drive bracket)

448153-001 120-GB, 5400-rpm hard drive (includes hard drive bracket)

448154001 160-GB, 5400-rpm hard drive (includes hard drive bracket)

448155001  200-GB, 4200-rpm hard drive (includes hard drive bracket)

448156-001  HD-DVD Drive (includes bezel and bracket)

448157001  DVDxRW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe (includes bezel and bracket)

448158001  Battery, 9-cell, 2.55-Ah, 83-Wh

448159-001  Keyboard for use in the United States

448159-031  Keyboard for use in the United Kingdom

448159-041  Keyboard for use in France

448159-051  Keyboard for use in Germany

448159-061  Keyboard for use in ltaly

448159-071  Keyboard for use in Spain

448159-121  Keyboard for use in French Canada

448159-161  Keyboard for use in Latin America

448159-AD1  Keyboard for use in South Korea

448159831  Keyboard for use in the Netherlands and Europe

448159-DH1  Keyboard for use in Denmark, Finland, Norway, and Sweden

448160001  180-W AC adapter

448161-001  Rear cover
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Spare part  Description

number

448162001 Processor fan

448163-001  Video board fan

448164001  Subwoofer (includes rubber isolators)

448165-001 Remote control for use in North America

448165002  Remote control for use in Europe, the Middle East, and Africa

448166-001  Fingerprint reader board (includes cable)

448167-001 TouchPad on/off board (includes cable)

448168-001 TV tuner module for use in North America

448168-002 TV tuner module for use in Europe, the Middle East, and Africa

448169-001 Cable Kit

448171001  Plastics Kit (see Plastics Kit on page 24 for more Plastics Kit information)

448172-001 Screw Kit

448173001  Base enclosure (includes microphone and speaker extension cables and rubber feet)

448174001  Top cover (includes TouchPad board cable and TouchPad button cable, and LED boards and cables)

448175001  Processor heat sink (includes replacement thermal material)

448176-001  Video board heat sink (includes replacement thermal material)

452063-001 Intel 802.11a/b/g WLAN module for use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados,
Bermuda, Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador,
El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia, Mexico, Panama,
Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United States, Venezuela, and Vietnam

452063-002  Intel 802.11a/b/g WLAN module for use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia,
Cyprus, the Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, ltaly, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco, the
Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania, Russia, Serbia and
Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey,
Ukraine, the United Kingdom, and Uzbekistan

452063-003  Intel 802.11a/b/g WLAN module for use in Australia, New Zealand, Pakistan, the People's Republic of Ching,
and South Korea

452299001  20.1-inch, WSXGA BrightView display assembly (includes camera module and cable, microphones, speakers,
and WLAN antennae)

452300-001  20.1-inch, WUXGA BrightView display assembly (includes camera module and cable, microphones, speakers,
and WLAN antennae)

452301-001  20.1-inch, WSXGA BrightView display panel

452302-001  20.1-inch, WUXGA BrightView display panel

452303-001  Display Bracket Kit

452304001  Camera module and camera module bracket

452306-001  Display hinge/enclosure (includes display cables)

452307-001  Display bezel (includes logos)

452308-001  Display inverter

Sequential part number listing 29



Spare part  Description

number

452309-001  Display Screw Kit

452310-001  Speaker Kit (includes left and right speakers)

452311001  Hinge cover

452312001 512-MB memory module (PC2-5300, 667-MHz, DDR2)

452313001  100-GB, 7200-rpm hard drive (includes hard drive bracket)

452314001  Front USB board (includes cable)

452315001  Rear USB board (includes cable)

452316-001 Audio/infrared board (includes cable)

452317-001  Audio connector board (includes cable)

452318-001  Power connector LED board (includes cable)

452319001 RTC battery

452320-001  Rubber Feet Kit (includes 11 computer feet in 4 sizes, and rubber screw covers)
452321-001  Video connector board (includes cable)

452322-001  nVidia video board (includes replacement thermal material)

452327001  Intel Core 2 Extreme X7800 2.6-GHz processor (includes replacement thermal material)
453908-001 Intel Core 2 Extreme X7900 2.8-GHz processor (includes replacement thermal material)
454311-001  nVidia video board (includes replacement thermal material)

454595-001  Display Rubber Pad Kit

454605-001  250-GB, 5400-rpm hard drive (includes hard drive bracket)

455738001 Intel Core 2 Extreme X7800 2.6-GHz processor (includes replacement thermal material)
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4 Removal and replacement
procedures

Preliminary replacement requirements

Tools required
You will need the following tools to complete the removal and replacement procedures:
e  Magnetic screwdriver
e  Phillips PO and P1 screwdrivers

o  Flatbladed screwdriver

Service considerations

The following sections include some of the considerations that you must keep in mind during disassembly
and assembly procedures.

B NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

Using excessive force during disassembly and reassembly can damage plastic parts. Use care when
handling the plastic parts. Apply pressure only at the points designated in the maintenance instructions.
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Cables and connectors

A CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with extreme
care; these cables tear easily.

Drive handling

A CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the computer
is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and be
sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.
Avoid exposing a drive fo temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
defermine the degree of sensitivity. Networks built into many integrated circuits provide some protection,

but in many cases, ESD contains enough power to alter device parameters or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or

microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a

normal cycle. Or the device may function normally for a while, then degrade in the internal layers,

reducing its life expectancy.

A CAUTION: To prevent damage to the computer when you are removing or installing internal

components, observe these precautions:

Keep components in their electrostatic-safe containers until you area ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described in

this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different

activities.

/A CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

Relative humidity

Event 10% 40% 55%
Walking across carpet 35,000 V 15,000 V 7,500 V
Walking across vinyl floor 12,000 V 5,000 V 3,000 V
Motions of bench worker 6,000V 800V 400 V
Removing DIPS from plastic tube 2,000 V 700V 400 V
Removing DIPS from vinyl tray 11,500 V 4,000V 2,000V
Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V
Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V
Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V

Preliminary replacement requirements
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.
Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

Place items on a grounded surface before removing items from their containers.

Always be properly grounded when touching a component or assembly.

Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive foam.

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that mechanized
equipment used for moving materials is wired to ground and that proper materials are selected to
avoid static charging. When grounding is not possible, use an ionizer to dissipate electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

Cover the workstation with approved static-shielding material.

Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

When fixtures must directly contact dissipative surfaces, use fixtures made only of staticsafe
materials.

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle these
items only at static-free workstations.

Avoid contact with pins, leads, or circuitry.

Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines
Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

e When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm +10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

e  When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps) can
be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one megohm
resistance between the operator and ground. To be effective, the conductive strips must be worn in
contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:
e  Antistatic tape

e  Antistatic smocks, aprons, and sleeve protectors

e  Conductive bins and other assembly or soldering aids

e Nonconductive foam

e  Conductive tabletop workstations with ground cords of one megohm resistance
e  Static-dissipative tables or floor mats with hard ties to the ground

e  Field service kits

e  Static awareness labels

e  Material-handling packages

e Nonconductive plastic bags, tubes, or boxes

e Metal tote boxes

e  Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level
Antistatic plastic Bags 1,500 V
Carbon-loaded plastic Floor mats 7,500 V
Metallized laminate Floor mats 5,000 V
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Unknown user password

If the computer you are servicing has an unknown user password, follow these steps to clear the password.

B NOTE: These steps also clear CMOS.

Before disassembling the computer, follow these steps:

1.

9.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 38).

Remove the RTC battery (see RTC battery on page 81).

Wait approximately 5 minutes.
Replace the RTC battery and reassemble the computer.
Connect AC power to the computer. Do not reinsert any batteries at this time.

Turn on the computer.

All passwords and all CMOS settings have been cleared.

36 Chapter 4 Removal and replacement procedures



Component replacement procedures

This chapter provides removal and replacement procedures.

There are as many as 154 screws, in 18 different sizes, that must be removed, replaced, or loosened
when servicing the computer. Make special note of each screw size and location during removal and
replacement.

Serial number

Report the computer serial number to HP when requesting information or ordering spare parts. The serial
number is located on the bottom of the computer.
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Battery

38

Description Spare part number

9-cell, 2.55-Ah, 83-Wh battery 448158-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery:
1. Turn the computer upside down on a flat surface.
2. Slide the battery release latch (1) to release the battery.

3.  Pivot the battery (2) upward and remove it from the computer (3).

To insert the battery, insert the rear edge of the battery info the battery bay and pivot the front edge of
the battery downward until it is seated. The battery release latch automatically locks the battery into place.
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Computer feet

Description Spare part number

Rubber Feet Kit (includes 11 computer feet in 4 sizes) 452320001

The computer feet are adhesive-backed rubber pads. The feet attach to the base enclosure in the locations
illustrated below.

e
I
I
I
I
I
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Display assembly internal components

Ef NOTE: Ifit has been determined that the display bezel, camera module, display inverter, display panel,
or speakers are the components that must be replaced to complete the computer repair, the display
assembly does not have to be completely removed from the computer. Replacement of these components
can be completed by removing only the display bezel. Follow the procedures in this section to replace
the display bezel, camera module, display inverter, display panel, or speakers. For information on
replacing the entire display assembly, see Display assembly on page 64.

Before removing the display bezel, follow these steps:

1.

4,

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 38).

Remove the display bezel:

1.
2.
3.

5.

Turn the computer display-side up, with the rear panel toward you.
Open the computer as far as possible.

Remove the two rubber screw covers from the back of the display assembly (1). All rubber screw
covers and logo labels removed in this section are included in the Display Rubber Pad Kit, spare part
number 454595-001.

Remove the two Phillips 2.5%5.0 screws (2) that secure the display bezel to the display enclosure.

Position the computer with the front toward you.

40 Chapter 4 Removal and replacement procedures



6.

Remove the following screw covers and logo labels:

(1) Two rubber screw covers on the display bezel top edge corners
(2) Two rubber screw covers on the display bezel top edge

(3) Four rubber screw covers on the display bezel left and right sides

(4) Speaker logo label on the display bezel lower left edge

(5) Computer model logo label on the display bezel lower right edge

Flex the inside edges of the left and right sides (1) and the top and bottom edges (2) of the display
bezel until the bezel disengages from the display enclosure.
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9. Remove the display bezel (3). The display bezel is available using spare part number
452307-001.

10. If it is necessary to replace the camera module, remove the two Phillips PM2.5x5.0 screws (1) that
secure the camera module to the display enclosure.

11. Release the camera module (2) from the display enclosure as far as the camera module cable allows.

12. Disconnect the camera module cable (3) from the camera module.

13. Remove the camera module. The camera module is available using spare part number
452304-001.

14. If it is necessary to replace the display inverter, remove the display inverter (1) from the display
enclosure as far as the two display inverter cables and the backlight cable allow.
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15. Disconnect the two display panel cables (2) and the backlight cable (3) from the display inverter.

16. Remove the display inverter. The display inverter is available using spare part number
452308-001.

17. Ifitis necessary to replace the display panel, remove the eight Phillips PM2.5x5.0 screws that secure
the display panel to the display enclosure.

18. Tiltthe top edge of the display panel (1) forward until the display panel cable connector is accessible.
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19.

20.

21.

22,

23.

Squeeze the tabs on the display panel cable connector (2) together and disconnect the cable (3)
from the display panel.

Remove the display panel. The display panel is available using spare part numbers 452301-001
(20.1-inch, WSXGA+BrightView) and 452302-001 (20.1-inch, WUXGA).

If it is necessary to replace the speakers, disconnect the speaker cable connectors (1) from the
speaker extension cable connectors.

Remove the two Phillips PM2.5x5.0 screws (2) that secure each speaker to the display enclosure.

Remove the speakers (3). The speakers are available using spare part number 452310-001

Reverse this procedure to install the display bezel, camera module, display inverter, display panel, and
speakers.
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Hard drive
B NOTE: All hard drive spare part kits include a hard drive bracket.

Description Spare part number
250-GB, 5400-rpm 454605-001
200-GB, 4200-rpm 448155-001
160-GB, 5400-rpm 448154001
120-GB, 7200-rpm 448152001
120-GB, 5400-rpm 448153-001
100-GB, 7200-rpm 452313-001

Before removing the hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).
Remove the hard drive:

1. Loosen the six black Phillips PM2.0x5.0 captive screws (1) that secure the hard drive bay cover to
the computer.

2. lift the rear edge of the hard drive bay cover (2), swing it forward, and remove the cover. The hard
drive bay cover is included in the Plastics Kit, spare part number 448171-001.

3. Loosen the Phillips PM2.5x12.0 screw (1) that secures each hard drive to the computer.

4. Disconnect the hard drives (2) from the system board by sliding the hard drives away from the hard
drive connectors.
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5. Remove the hard drives (3) from the hard drive compartments.

6. If it is necessary to replace the hard drive bracket, remove the four Phillips PM3.0x4.0 screws (1)
that secure the hard drive bracket to the hard drive.

7. Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.
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WLAN module

Description

Spare part number

Intel 802.11a/b/g/n WLAN modules:

For use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei,
Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador,
El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia,
Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United States,
Venezuela, and Vietnam

441086-001

For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the Czech
Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, ltaly, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta,
Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania,
Russia, Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka,
Sweden, Switzerland, Turkey, Ukraine, the United Kingdom, and Uzbekistan

441086-002

For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South Korea

441086-003

Intel 802.11a/b/g WLAN modules:

For use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei,
Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador,
El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia,
Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United States,
Venezuela, and Vietnam

452063-001

For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the Czech
Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, ltaly, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta,
Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania,
Russia, Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka,
Sweden, Switzerland, Turkey, Ukraine, the United Kingdom, and Uzbekistan

452063-002

For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South Korea

452063-003

Before removing the WLAN module, follow these steps:

1.

2,

3.

4.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the

computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and

then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 38).

Remove the WLAN module:

1.

2.

Position the computer with the front toward you.

Loosen the Phillips PM2.0x5.0 screw (1) that secures the WLAN module compartment cover to the

computer.
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3. Lift the right side of the WLAN module compartment cover (2), swing the cover up and to the left,
and remove the cover. The WLAN module compartment cover is included in the Plastics Kit, spare
part number 448171-001.

4. Disconnect the WLAN antenna cables (1) from the WLAN module.

Ef NOTE: The main WLAN antenna cable (labeled with the number 1 or with a black band) is
connected to the WLAN module “Main” terminal. The white WLAN antenna cable (labeled with the
number 2 or with a white band) is connected to the WLAN module “Aux” terminal. Computer models
equipped with an 802.11a/b/g/n WLAN module will have an additional wireless antenna
cable (2) (labeled with the number 3 or with a yellow band). Disconnect this cable.

5. Remove the two Phillips PM2.5x5.0 screws (3) that secure the WLAN module to the system board.
(The edge of the module opposite the slot rises away from the computer.)

6. Remove the WLAN module (4) by pulling it away from the slot at an angle.

Ef NOTE: WLAN modules are designed with a notch (5) to prevent incorrect installation into the
WLAN module slot.

Reverse this procedure to install a WLAN module.
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TV tuner module

Description Spare part number
For use only in Europe, the Middle East, and Africa 448168-002
For use only in North America 448168-001

Before removing the TV tuner module, follow these steps:

1.

4,

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 38).

Remove the TV tuner module:

1.

2,

3.

4.

5.

Position the computer with the front toward you.

Loosen the two black Phillips PM2.0x5.0 captive screws (1) that secure the TV tuner module
compartment cover to the computer.

Lift the left side of the TV tuner module compartment cover (2), swing the cover up and to the right,
and remove the cover. The TV tuner module compartment cover is included in the Plastics Kit, spare
part number 448171-001.

Disconnect the TV tuner cable (1) from the TV tuner module.

Remove the two Phillips PM2.5x5.0 screws (2) that secure the TV tuner module to the system board.
(The edge of the module opposite the slot rises away from the computer.)
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6. Remove the TV tuner module (3) by pulling it away from the slot at an angle.

Bf NOTE: The TV tuner module is designed with a notch (4) to prevent incorrect installation into the
TV tuner module slot.

Reverse this procedure to install the TV tuner module.

Memory module

Description Spare part number
2048-MB (667-MHz, PC2-5300, 1-DIMM) 448151001
1024-MB (667-MHz, PC2-5300, 1-DIMM) 448150001
512-MB (667-MHz, PC2-5300, 1-DIMM) 452312001

Before removing the memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

Remove the memory module:
1. Position the computer with the front toward you.

2. Loosen the two black Phillips PM2.0x5.0 captive screws (1) that secure the memory module
compartment cover to the computer.
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3.  Lift the rear edge of the cover (2), swing it forward, and remove the cover. The memory module
compartment cover is included in the Plastics Kit, spare part number 448171-001.

4. Spread the retaining tabs (1) on each side of the memory module slot to release the memory module.
(The edge of the module opposite the slot rises away from the computer.)

5. Remove the module (2) by pulling it away from the slot at an angle.

Ef NOTE: Memory modules are designed with a notch (3) to prevent incorrect installation into the
memory module slot.

Reverse this procedure to install a memory module.
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Optical drive

Ef NOTE: All optical drive spare part kits include an optical drive bezel and bracket.

Description Spare part number
HD-DVD 448156-001
DVD+RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe 448157001

Before removing the optical drive, follow these steps:

4,

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 38).

Remove the optical drive:

Position the computer with right side toward you.
Remove the Phillips PM2.5x8.0 screw (1) that secures the optical drive to the computer.

Insert a flat-bladed screwdriver or similar tool into the optical drive tab access (2) and press the tab
to the left to release the optical drive from the computer.

Remove the optical drive (3).

If it is necessary to replace the optical drive bracket, position the optical drive with the optical drive
bracket toward you.

Remove the two Phillips PM2.0x3.0 screws (1) that secure the optical drive bracket to the optical
drive.
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7. Remove the optical drive bracket (2).

Reverse the above procedure to reassemble and install the optical drive.
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Keyboard

Description

For use in: Spare part number For use in: Spare part number
Denmark, Finland, Norway, and 448159-DH1 Latin America 448159-161

Sweden

France 448159-051 South Korea 448159-AD1

French Canada 448159-121 Spain 448159-071
Germany 448159-041 The United Kingdom 448159-031

The Netherlands and Europe 448159-B31 The United States 448159-001

laly 448159.061

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the

computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the hard drives (see Hard drive on page 45).

Remove the keyboard:

1. Position the computer with the front toward you.

2. Remove the three Phillips PM2.5x8.0 screws (1) and the four Phillips PM2.5x5.0 screws (2) that
secure the keyboard to the computer.

3. Turn the computer display-side up, with the front toward you.
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4. Open the computer as far as possible.
5.  Lift the front edge of the keyboard (1) until it rests at an angle.

6. Slide the keyboard (2) forward until the tabs on the rear edge of the keyboard disengage from the
slots in the top cover.

7. Rotate the rear edge of the keyboard (3) forward until it rests upside down on the palm rest.

8. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached and
disconnect the keyboard cable (2).

9. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Hinge cover
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Description Spare part number

Hinge cover 452311-001

Before removing the hinge cover, follow these steps:

1.

4.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 38).

Remove the hinge cover:

1.
2.

Position the computer with the rear panel toward you.

Remove the four gray rubber screw covers (1) and (2) from the hinge cover. The screw covers come
in two different sizes and are available in the Rubber Feet Kit, spare part number 452320-001.

Remove the four Phillips PM3.0x8.0 screws (3) that secure the hinge cover to the computer.

Remove the hinge cover (4) by pulling it away from the computer.

Reverse this procedure to install the hinge cover.
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Rear cover

Description Spare part number

Rear cover 448161-001

Before removing the rear cover, follow these steps:

1.

4.
5.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 38).

Remove the hinge cover (see Hinge cover on page 56).

Remove the rear cover:

1.
2.

5.

Position the computer with the front toward you.
Remove the seven Phillips PM2.5x8.0 screws (1) that secure the rear cover to the computer.

Remove the Mylar screw cover (2) in the optical drive bay. This screw cover is available in the Rubber
Feet Kit, spare part number 452320-001.

Remove the Phillips PM2.5x4.0 screw (3) that secures the rear cover to the computer.

Remove the four Phillips PM3.0x12.0 screws (1) that secure the rear cover to the computer.

Component replacement procedures 57



6. Remove the four Phillips PM2.5x4.0 broad-head screws (2) that secure the rear cover to the
computer.

7. Turn the computer rightside up, with the front toward you.
8. Open the computer as far as possible.

9. Remove the rear cover.

Reverse this procedure to install the rear cover.
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Top cover

Description Spare part number

Top cover (includes TouchPad board cable and TouchPad button cable, and LED boards and cables) 448174-001

Before removing the top cover, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 38).

Remove the following components:

a. Hard drive (see Hard drive on page 45)

b. Optical drive (see Optical drive on page 52)

c. Keyboard (see Keyboard on page 54)

d. Hinge cover (see Hinge cover on page 56)

e. Rear cover (see Rear cover on page 57)

Remove the top cover:

1.
2.

Turn the computer upside down, with the front toward you.

Remove the two Mylar screw covers (1) in the optical drive bay. These screw covers are available
in the Rubber Feet Kit, spare part number 452320-001.

Remove the two Phillips PM2.5x4.0 screws (2) and the ten Phillips PM2.5x8.0 screws (3) that secure
the top cover to the computer.

| — — — —

;
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4. Remove the four Phillips PM2.5x5.0 screws (1) and the two Phillips PM2.5x11.0 screws (2) that
secure the top cover to the computer.
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5. Turn the computer rightside up, with the front toward you.
6. Open the computer as far as possible.
7. Disconnect the following cables:

(1) Fingerprint reader board cable

(2) LED board cable

(3) TouchPad board cable

(4) TouchPad on/off board cable

8. Remove the two Phillips PM2.5x5.0 screws (1) that secure the top cover to the computer.
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9. Lift the rear edge of the top cover (2) until the top cover disengages from the computer.

10. Remove the top cover.

Reverse this procedure to install the top cover.

Fingerprint reader board

Description Spare part number

Fingerprint reader board (includes cable) 448166-001

Before removing the fingerprint reader board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).
5. Remove the following components:

a. Hard drive (see Hard drive on page 45)

b. Optical drive (see Optical drive on page 52)

c. Keyboard (see Keyboard on page 54)

d. Hinge cover (see Hinge cover on page 56)

e. Rear cover (see Rear cover on page 57)

f. Top cover (see Top cover on page 59)
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Remove the fingerprint reader board:
1. Turn the top cover upside down, with the front toward you.

2. Remove the two silver Phillips PM2.0x4.0 screws (1) that secure the fingerprint reader board and
bracket to the top cover.

3. Remove the fingerprint reader board bracket (2) and fingerprint reader board (3).

Reverse this procedure to install the fingerprint reader board.

TouchPad on/off board

Description Spare part number

TouchPad on/off board (includes cable) 448167001

Before removing the TouchPad on/off board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the following components:

a. Hard drive (see Hard drive on page 45)

b. Optical drive (see Optical drive on page 52)

c. Keyboard (see Keyboard on page 54)

d. Hinge cover (see Hinge cover on page 56)
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e. Rear cover (see Rear cover on page 57)

f. Top cover (see Top cover on page 59)

Remove the TouchPad on/off board:
1. Turn the top cover upside down, with the front foward you.

2. Remove the two silver Phillips PM2.0x4.0 screws (1) that secure the TouchPad on/off board to the
top cover.

3. Remove the TouchPad on/off board (2).

Reverse this procedure to install the TouchPad on/off board.
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Display assembly

Description Spare part number

20.1-inch, WSXGA BrightView display assembly (includes camera module and cable, microphones, 452299-001
speakers, and WLAN antennae)

20.1-inch, WUXGA BrightView display assembly (includes camera module and cable, microphones, 452300-001
speakers, and WLAN antennae)

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Disconnect the WLAN module antenna cables from the WLAN module (see WLAN module
on page 47).

6. Remove the following components:

a. Hard drive (see Hard drive on page 45)

b. Optical drive (see Optical drive on page 52)

c. Keyboard (see Keyboard on page 54)

d. Hinge cover (see Hinge cover on page 56)

e. Rear cover (see Rear cover on page 57)

f. Top cover (see Top cover on page 59)
Remove the display assembly:

1. Close the computer and turn it upside down, with the front toward you.
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2. Remove the six Phillips PM3.0x8.0 screws that secure the display assembly to the computer.

3. Turn the computer display-side up, with the front foward you.
4. Open the computer to an upright position.
5. Disconnect the following cable connectors:

(1) Display panel cable

(2) Camera module cable

(3) Speaker cable

(4) Microphone cable

B NOTE: The speaker cables are black and red and share a single connector. The microphone cables
are gray and white and share a single connector. Be sure that these connectors are correctly
reconnected when installing the display assembly.
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6. Remove the WLAN antenna cables (5) from the opening in the system board.

A CAUTION: The display assembly will be unsupported when the following screws are removed. To
prevent damage to the display assembly, support the display assembly before removing the screws.

7. Remove the six Phillips PM3.0x8.0 screws (1) that secure the display assembly to the computer.

8. Remove the display assembly (2).

B NOTE: Ifitis necessary to replace any of the display assembly internal components, see Display
assembly internal components on page 40 for display bezel removal information.

Reverse this procedure to install the display assembly.
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Audio/infrared board

Description Spare part number

Audio/infrared board 452316001

Before removing the audio/infrared board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).
5. Remove the following components:

a. Hard drive (see Hard drive on page 45)

b. Optical drive (see Optical drive on page 52)

c. Keyboard (see Keyboard on page 54)

d. Hinge cover (see Hinge cover on page 56)

e. Rear cover (see Rear cover on page 57)

f. Top cover (see Top cover on page 59)

Remove the audio/infrared board:
1. Disconnect the audio/infrared board cable (1) from the system board.
2. Remove the two Phillips PM2.5x5.0 screws (2) that secure the audio/infrared board to the computer.

3. Remove the audio/infrared board (3) from the base enclosure.
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Reverse this procedure to install the audio/infrared board.

Bluetooth module

Ef NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is available in the Cable Kit, spare part number 448169-001.

Description Spare part number

Bluetooth module 398393-002

Before removing the Bluetooth module, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 38).

Remove the following components:

a.

b.

e.

f.

Hard drive (see Hard drive on page 45)

Optical drive (see Optical drive on page 52)

Keyboard (see Keyboard on page 54)

Hinge cover (see Hinge cover on page 56)

Rear cover (see Rear cover on page 57)

Top cover (see Top cover on page 59)

Remove the Bluetooth module:

1.

2.

Disconnect the Bluetooth module cable (1) from the system board.

Remove the two silver Phillips PM2.0x4.0 screws (2) that secure the Bluetooth module to the
computer.
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3. Remove the Bluetooth module (3) from the base enclosure.

Reverse this procedure to install the Bluetooth module.

Front USB board

Description Spare part number

Front USB board 452314001

Before removing the front USB board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the following components:

a. Hard drive (see Hard drive on page 45)

b. Optical drive (see Optical drive on page 52)

c. Keyboard (see Keyboard on page 54)

d. Hinge cover (see Hinge cover on page 56)

e. Rear cover (see Rear cover on page 57)

f. Top cover (see Top cover on page 59)
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Remove the front USB board:
1. Disconnect the front USB board cable (1) from the system board.
2. Remove the two Phillips PM2.5x4.0 screws (2) that secure front USB board the to the computer.

3. Remove the front USB board (3).

Reverse this procedure to install the front USB board.

Power connector LED board

Description Spare part number

Power connector LED board (includes cable) 452318-001

Before removing the power connector LED board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the following components:

a. Hard drive (see Hard drive on page 45)

b. Optical drive (see Optical drive on page 52)

c. Keyboard (see Keyboard on page 54)

d. Hinge cover (see Hinge cover on page 56)
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e. Rear cover (see Rear cover on page 57)

f. Top cover (see Top cover on page 59)

Remove the power connector LED board:
1. Disconnect the power connector LED board (1) from the system board.

2. Remove the power connector LED board (2).

Reverse this procedure to install the power connector LED board.

Rear USB board

Description Spare part number

Rear USB board (includes cable) 452315001

Before removing the rear USB board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the following components:

a. Hard drive (see Hard drive on page 45)

b. Optical drive (see Optical drive on page 52)

c. Keyboard (see Keyboard on page 54)

d. Hinge cover (see Hinge cover on page 56)
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e. Rear cover (see Rear cover on page 57)

f. Top cover (see Top cover on page 59)

Remove the rear USB board:
1. Disconnect the rear USB board cable (1) from the system board.
2. Remove the Phillips PM2.5x4.0 screw (2) that secures rear USB board the to the computer.

3. Remove the rear USB board (3).

Reverse this procedure fo install the rear USB board.

Subwoofer
Description Spare part number
Subwoofer (includes rubber isolators) 448164001

Before removing the subwoofer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the following components:

a. Hard drive (see Hard drive on page 45)

b. Optical drive (see Optical drive on page 52)

c. Keyboard (see Keyboard on page 54)

72 Chapter 4 Removal and replacement procedures



d. Hinge cover (see Hinge cover on page 56)

e. Rear cover (see Rear cover on page 57)

f. Top cover (see Top cover on page 59)

Remove the subwoofer:
1. Disconnect the subwoofer cable (1) from the system board.
2.  Remove the three Phillips PM2.5x8.0 screws (2) that secure subwoofer the to the base enclosure.

3. Remove the subwoofer (3).

A CAUTION: When installing the subwoofer, do not overtighten the screws. Overtightening the
subwoofer screws can result in damage to the subwoofer grommets (4), which can cause a decrease
in the subwoofer performance.

Reverse this procedure to install the subwoofer.

Video connector board

Description Spare part number

Video connector board (includes cable) 452321001

Before removing the audio connector board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.
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4. Remove the battery (see Battery on page 38).
5. Remove the following components:

a. Hard drive (see Hard drive on page 45)

b. Optical drive (see Optical drive on page 52)

c. Keyboard (see Keyboard on page 54)

d. Hinge cover (see Hinge cover on page 56)

e. Rear cover (see Rear cover on page 57)

f. Top cover (see Top cover on page 59)

g. Subwoofer (see Subwoofer on page 72)

Remove the video connector board:
1. Disconnect the video connector board cable (1) from the system board.

2. Remove the Phillips PM2.5x4.0 screw (2) that secures the video connector board to the base
enclosure.

3. Route the video connector board cable under the processor heat sink pipe (3).

4. Remove the video connector board (4) from the base enclosure.

Reverse this procedure to install the video connector board.
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Processor fan

Description Spare part number

Processor fan 448162-001

B NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-inch) clearance on the left and
right sides and rear panel of the computer. The computer uses two electric fans for ventilation. The fans
are controlled by a temperature sensor and are designed to turn on automatically when high temperature
conditions exist. These conditions are affected by high external temperatures, system power consumption,
power management/battery conservation configurations, battery fast charging, and software
requirements. Exhaust air is displaced through the ventilation grills located on the computer rear panel.

Before removing the processor fan, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the following components:

a. Hard drive (see Hard drive on page 45)

b. Optical drive (see Optical drive on page 52)

c. Keyboard (see Keyboard on page 54)

d. Hinge cover (see Hinge cover on page 56)

e. Rear cover (see Rear cover on page 57)

f. Top cover (see Top cover on page 59)

g. Subwoofer (see Subwoofer on page 72)

Remove the processor fan:
1. Disconnect the processor fan cable (1) from the system board.

2. Remove the two Phillips PM2.5x8.0 screws (2) that secure the processor fan to the base enclosure.
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3. Remove the processor fan (3).

Reverse this procedure to install the processor fan.

System board

Description Spare part number
System board (includes power connector cable, ExpressCard assembly, and replacement thermal 448145001
material)

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the following components:

a. Hard drive (see Hard drive on page 45)

b. Optical drive (see Optical drive on page 52)

c. Keyboard (see Keyboard on page 54)

d. Hinge cover (see Hinge cover on page 56)

e. Rear cover (see Rear cover on page 57)

f. Top cover (see Top cover on page 59)

g. Subwoofer (see Subwoofer on page 72)

h. Processor fan (see Processor fan on page 75)
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When replacing the system board, be sure that the following components are removed from the defective
system board and installed on the replacement system board:

e Memory module (see Memory module on page 50)

e  RTC battery (see RTC battery on page 81)

e  WILAN module (see WLAN module on page 47)

Remove the system board:
1. Remove the power connector (1) from the clip built into the base enclosure.

2. Disconnect the rear USB board cable (2) and the power connector LED board cable (3) from the
system board.
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3. Disconnect the following cable connectors from the system board:
(1) Speaker cable
(2) Microphone cable
(3) Audio/infrared board cable
(4) Subwoofer cable

(5) Audio connector board cable

4. Disconnect the following cables from the system board:
(1) Bluetooth module cable
(2) Front USB board cable
(3) Processor fan cable

(4) Composite video connector board cable

5. Remove the two SM1.5x9.0 screws (1) on each side of the expansion port 3 connector.
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6. Remove the four Phillips PM2.5x4.0 screws (2) that secure the system board to the base enclosure.

7. Loosen the captive Phillips PM2.5x14.0 screw (3) that secures the video heat sink and system board
to the base enclosure.

8.  Use the optical drive connector (1) to lift the right side of the system board (2) until it rests at an
angle.

9. Remove the system board (3) by pulling it away from the base enclosure at an angle.

Reverse this procedure to install the system board.
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Audio connector board

Description Spare part number

Audio connector board (includes cable) 452317001

Before removing the audio connector board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the following components:

a. Hard drive (see Hard drive on page 45)

b. Optical drive (see Optical drive on page 52)

c. Keyboard (see Keyboard on page 54)

d. Hinge cover (see Hinge cover on page 56)

e. Rear cover (see Rear cover on page 57)

f. Top cover (see Top cover on page 59)

g. Subwoofer (see Subwoofer on page 72)

h. System board (see System board on page 76)

Remove the audio connector board:

1. Remove the two Phillips PM2.5x5.0 screws (1) that secure the audio connector board to the base
enclosure.

2. Remove the audio connector board cable (2) from the clips built into the base enclosure.
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3. Remove the audio connector board (3) from the base enclosure.

Reverse this procedure to install the audio connector board.

RTC battery

B NOTE: Removing the RTC battery and leaving it uninstalled for 5 or more minutes causes all passwords
and CMOS settings to be cleared.

Description Spare part number

RTC battery 452319001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the following components:

a. Hard drive (see Hard drive on page 45)

b. Optical drive (see Optical drive on page 52)

c. Keyboard (see Keyboard on page 54)

d. Hinge cover (see Hinge cover on page 56)

e. Rear cover (see Rear cover on page 57)

f. Top cover (see Top cover on page 59)
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g. Subwoofer (see Subwoofer on page 72)

h. System board (see System board on page 76)

Remove the RTC battery:

A Remove the RTC battery from the socket on the system board.

Reverse this procedure fo install the RTC battery.
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Processor heat sink

Description Spare part number

Processor heat sink (includes replacement thermal material) 448175001

Before removing the processor heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the following components:

a. Hard drive (see Hard drive on page 45)

b. Optical drive (see Optical drive on page 52)

c. Keyboard (see Keyboard on page 54)

d. Hinge cover (see Hinge cover on page 56)

e. Rear cover (see Rear cover on page 57)

f. Top cover (see Top cover on page 59)

g. Subwoofer (see Subwoofer on page 72)

h. System board (see System board on page 76)

Remove the processor heat sink:
1. Turn the system board upside down, with the front toward you.

2. Loosen the three silver Phillips PM2.0x5.0 captive screws (1) that secure the processor heat sink to
the system board.

3. Remove the processor heat sink clip (2) by sliding it fo the right.
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4. Remove the processor heat sink (3).

B NOTE: Due to the adhesive quality of the thermal material located between the processor heat sink
and system board components, it may be necessary to move the processor heat sink from side to
side to detach it.

Ef NOTE: The thermal material must be thoroughly cleaned from the surfaces of the processor heat
sink (1) and the system board (2) each time the processor heat sink is removed. Thermal material
must be installed on all surfaces before the processor heat sink is reinstalled. Replacement thermal
material is included with all processor heat sink, system board, and processor spare part kits, and
is also available using spare part number 413706-001.

_ig B

Reverse this procedure to install the processor heat sink.
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Processor

B NOTE: All processor spare part kits include replacement thermal material.

Desription Spare part number

Intel Core 2 Extreme processors (4-MB L2 cache, 800-MHz FSB, 44-W):

X7900 2.8-GHz processor 453908-001
X7800 2.6-GHz processor 455738-001 and
452327-001

Intel Core 2 Duo processors (4-MB L2 cache, 800-MHz FSB, 35-W):

T7700 2.4-GHz processor 448148-001
T7500 2.2-GHz processor 448147-001
T7300 2.0-GHz processor 448146-001
T7100 1.8-GHz processor 448149001

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the following components:

a. Hard drive (see Hard drive on page 45)

b. Optical drive (see Optical drive on page 52)

c. Keyboard (see Keyboard on page 54)

d. Hinge cover (see Hinge cover on page 56)

e. Rear cover (see Rear cover on page 57)

f. Top cover (see Top cover on page 59)

g. Subwoofer (see Subwoofer on page 72)

h. System board (see System board on page 76)

i.  Processor heat sink (see Processor heat sink on page 83)

Remove the processor:

1. Turn the processor locking screw (1) one-half turn counterclockwise until you hear a click.
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2.  lift the processor (2) straight up and remove it.

B NOTE: The gold triangle (3) on the processor must be aligned with the triangle icon (4) embossed
on the processor slot when you install the processor.

o ? W
,<;=>

Reverse this procedure fo install the processor.
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Video board heat sink

Description Spare part number

Video board heat sink (includes replacement thermal material) 448176001

Before removing the video board heat sink, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 38).

Remove the following components:

a. Hard drive (see Hard drive on page 45)

b. Optical drive (see Optical drive on page 52)

c. Keyboard (see Keyboard on page 54)

d. Hinge cover (see Hinge cover on page 56)

e. Rear cover (see Rear cover on page 57)

f. Top cover (see Top cover on page 59)

g. Subwoofer (see Subwoofer on page 72)

h. System board (see System board on page 76)

Remove the video board heat sink:

1.
2.

Turn the system board upside down, with the front toward you.
Disconnect the video board fan cable (1) from the system board.

Loosen the two Phillips PM2.5%9.0 captive screws (2) and the four silver Phillips PM2.0x5.0 captive
screws (3) that secure the video board heat sink to the system board.
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4. Remove the video board heat sink (4).

Bf NOTE: Due to the adhesive quality of the thermal material located between the video board heat
sink and system board components, it may be necessary to move the video board heat sink from
side to side to detach it.

B NOTE: The thermal material must be thoroughly cleaned from the surfaces of the video board
components (1) and the video board heat sink (2) each time the video board heat sink is removed.
Thermal material must be installed on all surfaces before the video board heat sink is reinstalled.
Replacement thermal material is included with all video board heat sink and video board spare part
kits, and is also available using spare part number 413706-001.

Reverse this procedure to install the video board heat sink.
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Video board fan

Description Spare part number

Video board fan 448163-001

B NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-inch) clearance on the left and
right sides and rear panel of the computer. The computer uses two electric fans for ventilation. The fans
are controlled by a temperature sensor and are designed to turn on automatically when high temperature
conditions exist. These conditions are affected by high external temperatures, system power consumption,
power management/battery conservation configurations, battery fast charging, and software
requirements. Exhaust air is displaced through the ventilation grills located on the computer rear panel.

Before removing the video board fan, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the following components:

a. Hard drive (see Hard drive on page 45)

b. Optical drive (see Optical drive on page 52)

c. Keyboard (see Keyboard on page 54)

d. Hinge cover (see Hinge cover on page 56)

e. Rear cover (see Rear cover on page 57)

f. Top cover (see Top cover on page 59)

g. Subwoofer (see Subwoofer on page 72)

h. System board (see System board on page 76)

i.  Video board heat sink (see Video board heat sink on page 87)

Remove the video board fan:
1. Turn the video heat sink upside down.

2. Remove the three black Phillips PM2.0x4.0 screws (1) that secure the video board fan to the video
board heat sink.
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3.  Remove the video board fan (2).

Reverse this procedure to install the video board fan.

Video board

Description Spare part number

nVidia video board (includes replacement thermal material) 454311-001

Before removing the video board fan, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the following components:

a. Hard drive (see Hard drive on page 45)

b. Optical drive (see Optical drive on page 52)

c. Keyboard (see Keyboard on page 54)

d. Hinge cover (see Hinge cover on page 56)

e. Rear cover (see Rear cover on page 57)

f. Top cover (see Top cover on page 59)

g. Subwoofer (see Subwoofer on page 72)
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h. System board (see System board on page 76)

i.  Video board heat sink (see Video board heat sink on page 87)

Remove the video board:
1. Remove the two Phillips PM2.5%x4.0 screws (1) that secure the video board to the system board.
2. Lift the right side of the video board (2) until it rests at an angle.

3. Remove the video board (3) by pulling it away from the video board slot at an angle.

B NOTE: Video boards are designed with a notch (4) to prevent incorrect installation into the video
board slot.

Reverse this procedure fo install the video board.
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9 Computer Setup

Starting Computer Setup

Computer Setup is a ROM-based information and customization utility that can be used even when the
Windows operating system is not working or will not load.

EX NOTE: The fingerprint reader does not work when accessing Computer Setup.

The utility reports information about the computer and provides settings for startup, security, and other
preferences.

To start Computer Setup:
1. Turn on or restart the computer.

2. Before Windows opens and while "F10 = ROM Based Setup" is displayed in the lower-left corner
of the screen, press f10.
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Using Computer Setup
Changing the language of Computer Setup

The following procedure explains how to change the language of Computer Setup. If Computer Setup is
not already running, begin at step 1.

1. To start Computer Setup, turn on or restart the computer, and then press {10 while “F10 = ROM
Based Setup” is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select System Configuration > Language, and then press enter.
3. Use the arrow keys to select a language, and then press f10.
4.  When the confirmation prompt is displayed, press {10 to save your preference.

5. To set your preferences and exit Computer Setup, select File > Save Changes And Exit, and
then follow the instructions on the screen.

Your preferences go info effect when the computer restarts in Windows.

Navigating and selecting in Computer Setup

Because Computer Setup is not Windows-based, it does not support the TouchPad. Navigation and
selection are by keystroke.

e To choose a menu or a menu item, use the arrow keys.
e Toselect an item, press f10.
e To close a text box or return to the menu display, press esc.

e To display additional navigation and selection information while Computer Setup is open,, press

f1.

Displaying system information

The following procedure explains how to display system information in Computer Setup. If Computer Setup
is not open, begin at step 1. If Computer Setup is open, begin at step 2.

1. To start Computer Setup, turn on or restart the computer, and then press {10 while “F10 = ROM
Based Setup” is displayed in the lower-left corner of the screen.

2. Access the system information by using the File menu.

3. To exit Computer Setup without changing any settings, use the arrow keys to select File > Ignore
Changes And Exit, and then follow the instructions on the screen.
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Restoring default settings in Computer Setup

The following procedure explains how to restore Computer Setup default settings. If Computer Setup is
not already running, begin at step 1. If Computer Setup is already running, begin at step 2.

1. To start Computer Setup, turn on or restart the computer, and then press 10 while “F10 = ROM
Based Setup” is displayed in the lower-left corner of the screen.

2. Select File > Restore Defaults, and then press enter.
3.  Follow the instructions on the screen.

Computer Setup default settings are set when you exit Computer Setup and go into effect when the
computer restarts.

B NOTE: Your password, security, and language settings are not changed when you restore the factory
default settings.

Closing Computer Setup
You can close Computer Setup with or without saving changes.

e To close Computer Setup and save your changes from the current session, use either of the following
procedures:

o Press {10, and then follow the instructions on the screen.

o If the Computer Setup menus are not visible, press esc to return to the menu display. Then use
the arrow keys to select File > Save Changes And Exit, and then press enter.

When you use the 10 procedure, you are offered an option to return to Computer Setup. When
you use the Save Changes And Exit procedure, Computer Setup closes when you press enter.

e To close Computer Setup without saving your changes from the current session:

If the Computer Setup menus are not visible, press esc to return to the menu display. Then use the
arrow keys to select File > Ignore Changes And Exit, and then press enfer.

After Computer Setup closes, the computer restarts in Windows.
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Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

Ef NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your

computer.
il
File menu

Select To do this

System information e  View identification information about the computer.
e  View specification information for the processor, memory, and system ROM.

Restore defaults Replace the configuration settings in Computer Setup with factory settings.
(Password and security settings are not changed when you restore the factory
seftings.)

Ignore changes and exit Cancel any changes entered during the current session. Then exit and restart the
computer.

Save changes and exit Save changes entered during the current session. Then exit and restart the computer.

Your changes go info effect when the computer restarts.
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Security menu

Select

To do this

Setup password

Enter, change, or delete a setup password.

Power-On password

Enter, change, or delete a power-on password.

Diagnostics menu

Select

To do this

Hard Drive Self-Test options

Run a comprehensive selftest on any hard drive in the system.

Memory Check

Run a comprehensive check on system memory.
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System Configuration menu

B NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select

To do this

Language (or press 2)

Change the Computer Setup language.

Boot options

Set 9, 10, and {12 delay when starting up.
Enable/disable CD-ROM boot.
Enable/disable floppy boot.

Enable/disable internal network adapter boot.
Set the Express Boot Popup delay in seconds.

Set the boot order.

Device configurations

Enable/disable Virtualization Technology.

Enable/disable button sound.

Computer Setup menus
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6 Specifications

Computer specifications

Metric u.s.
Dimensions
Width 47.5 cm 18.70 in
Depth 33.9cm 13.35in
Height 5.9 cm 2.32in
Weight (with optical drive, hard drive, ~ 7.00 kg 15.44 lbs
and battery)
Second hard drive adds: 0.13 kg 0.28 lbs
Camera adds: 0.009 kg 0.02 lbs
Input power
Operating voltage 18.5Vdc@3.5A-180 W
Operating current 3.5A0r4.74 A
Temperature
Operating (not writing fo optical disc) 0°C to 35°C 32°F to 95°F
Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F
Nonoperating -20°C to 60°C -4°F to 140°F
Relative humidity
Operating 10% to 90%
Nonoperating 5% to 95%
Maximum altitude (unpressurized)
Operating (14.7 to 10.1 psia) -15 mto 3,048 m -50 ft to 10,000 ft
Nonoperating (14.7 to 4.4 psia) -15mto 12,192 m -50 ft to 40,000 ft
Shock
Operating 125 g, 2 ms, halfsine
Nonoperating 200 g, 2 ms, halfsine

Random vibration
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Metric uU.S.

Operating 0.75 g zeroto-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate

Nonoperating 1.50 g zeroto-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this
range of temperatures.

20.1-inch, WUXGA display specifications

Metric u.s.
Dimensions
Height 27.40 cm 10.79 in
Width 43.55 cm 17.15in
Diagonal 51.10 cm 20.11in
Number of colors Up to 16.8 million
Contrast ratio 200:1 (typical)
Brightness 180 nits (typical)
Pixel resolution
Pitch 0.172 x 0.172 mm
Format 1920 x 1200
Configuration RGB vertical stripe
Backlight CCFT
Character display 80 x 25
Total power consumption 6.0 W
Viewing angle +/-65° horizontal, +/-50° vertical (typical)
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20.1-inch WSXGA+ display specifications

Metric u.s.
Dimensions
Height 27.40 cm 10.79in
Width 43.55 cm 17.15in
Diagonal 51.10 cm 20.11in
Number of colors Up to 16.8 million
Contrast ratio 200:1
Brightness 180 nits typical
Pitch resolution
Pitch 0.172 x 0.172 mm
Format 1680 x 1050
Configuration RGB vertical stripe
Backlight CCFT
Character display 80 x 25
Total power consumption 7.0W
Viewing angle +/-60° horizontal, +40/-50° vertical typical
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Hard drive specifications

250-GB* 200-GB* 160-GB* 120-GB* 100-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm 9.5 mm
Width 70 mm 70 mm 70 mm 70 mm 70 mm
Weight 101 g 101 g 101 g 101 g 101 g
Interface type ATA-7 ATA-7 ATA-7 ATA-7 ATA7

Transfer rate

Synchronous (maximum) 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security  ATA security ~ ATA security ~ ATA security  ATA security

Seek times (typical read, including setting)

Single track 3 ms 3 ms 3 ms 3 ms 3ms

Average 13 ms 13 ms 13 ms 13 ms 13 ms

Maximum 24 ms 24 ms 24 ms 24 ms 24 ms

Logical blocks 495,665,15 396,532,12 317,249,69 237,937,27 198,281,06
5 4 9 4 2

Disc rotational speed 5400-rpm 4200-rpm 5400-rpm 7200- and 5400-rpm

5400-rpm
Operating temperature 5°Cto 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.

NOTE: Certlain restrictions and exclusions apply. Contact technical support for details.
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DVD+RW and CD-RW Super Multi Double-Layer
Combo Drive specifications

Applicable disc

Read: Write:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT,  CD-R and CD-RW

CD-ROM, CD-ROM XA, MIXED MODE

CD, CD-, CD Bridge (Photo-CD, Video DVD+R, DVD+RW, DVD-R, DVDRW,
CD), Multisession CD (Photo-CD, CD- ~ DVD-RAM

EXTRA, Portfolio, CDR, CD-RW), CDR,

CD-RW, DVD-ROM (DVD-5, DVD-9,

DVD-10, DVD-18), DVDR, DVDRW,

DVD+R, DVD+RW, DVD-RAM

Center hole diameter 1.5 cm (0.59 in)

Disc diameter

Standard disc 12 cm (4.72 in)

Mini disc 8 cm (3.15in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 um

Access time cD DVD
Random <175 ms <230 ms
Full stroke <285 ms <335 ms

Audio output level

Audio-out, 0.7 Vrms

Cache buffer

2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec
8X DVD 10,800 KB/sec
24X CDR 3,600 KB/sec
16X CD-RW 2,400 KB/sec
8X DVD+R 10,800 KB/sec
4X DVD+RW 5,400 KB/sec
8X DVDR 10,800 KB/sec
4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9)

2,700 KB/sec

5X DVD-RAM

6,750 KB/sec

Transfer mode

Multiword DMA Mode

Startup time

< 15 seconds

Stop time

< 6 seconds
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System DMA specifications

Hardware DMA System function

DMAO Not applicable

DMAT1* Not applicable

DMA2* Not applicable

DMA3 Not applicable

DMA4 Direct memory access controller
DMA5* Available for PC Card

DMA6 Not assigned

DMA7 Not assigned

*PC Card controller can use DMA 1, 2, or 5.
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System interrupt specifications

Hardware IRQ System function

IRQO System timer

IRQ1 Standard 101-/102-Key or Microsoft® Natural Keyboard

IRQ2 Cascaded

IRQ3 Intel 82801DB/DBM USB2 Enhanced Host Controller—24CD

IRQ4 COMI1

IRQ5* Conexant AC—Link Audio Intel 82801DB/DBM SMBus Controller—
24C3 Data Fax Modem with SmartCP

IRQ6 Diskette drive

IRQ7* Parallel port

IRQ8 System CMOS/realtime clock

IRQ9* Microsoft ACPl-compliant system

IRQ10* Intel USB UHCI controller—24C2

Intel 82852/82855 GM/GME Graphic Controller

Realtek RTL8139 Family PCl Fast Ethernet Controller

RQ11 Intel USB EHCI controller—24CD
Intel USB UHCI controller—24C4
Intel USB UHCI controller—24C7
Intel Pro/Wireless 2200BG
TI OHCI 1394 host controller

TI PCI1410 CardBus controller

IRQ12 Synaptics PS/2 TouchPad
IRQ13 Numeric data processor
IRQ14 Primary IDE channel
IRQ15 Secondary IDE channel

*Default configuration; audio possible configurations are IRQ5, IRQ7, IRQY, IRQ10, or none.

NOTE: PC Cards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQY, IRQ10, IRQ11, or IRQ15. Either the infrared or the serial port
may assert RQ3 or IRQ4.
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System I/O address specifications

1/0 address (hex) System function (shipping configuration)
000 - OOF DMA controller no. 1

010-01F Unused

020 - 021 Interrupt controller no. 1

022-024 Opti chipset configuration registers
025 - O3F Unused

02E - 02F 87334 “Super I/O" configuration for CPU
040 - 05F Counter/timer registers

044 - 05F Unused

060 Keyboard controller

061 Port B

062 -063 Unused

064 Keyboard controller

065 - 06F Unused

070-071 NMI enable/RTC

072 - 07F Unused

080 - 08F DMA page registers

090 - 091 Unused

092 Port A

093 - 09F Unused

0AO - OA1 Interrupt controller no. 2

I/O Address (hex) System function (shipping configuration)
OAZ2 - OBF Unused

0CO - ODF DMA controller no. 2

OEO - OEF Unused

OF0 - OF1 Coprocessor busy clear/reset

OF2 - OFF Unused

100 - 16F Unused

170-177 Secondary fixed disk controller
178 - 1EF Unused

1FO - 1F7 Primary fixed disk controller

1F8 - 200 Unused

201 JoyStick (decoded in ESS1688)
202 - 21F Unused

System 1/O address specifications 105



1/0 address (hex) System function (shipping configuration)

220 - 22F Entertainment audio

230- 26D Unused

26E - 26 Unused

278 - 27F Unused

280 - 2AB Unused

2A0 - 2A7 Unused

2A8 - 2E7 Unused

2E8 - 2EF Reserved serial port

2F0 - 2F7 Unused

2F8 - 2FF Infrared port

300-31F Unused

320 - 36F Unused

370-377 Secondary diskette drive controller
378 - 37F Parallel port (LPT1/default)

380- 387 Unused

388 -38B FM synthesizer—OPL3

38C- 3AF Unused

3BO - 3BB VGA

3BC - 3BF Reserved (parallel port/no EPP support)
3CO0 - 3DF VGA

3EO0 - 3E1 PC Card controller in CPU

3E2 - 3E3 Unused

3E8 - 3EF Internal modem

3F0 - 3F7 “A" diskette controller

3F8 - 3FF Serial port (COM1/default)

CF8 - CFB PCl configuration index register (PCIDIVO-1)
CFC - CFF PCl configuration data register (PCIDIVO-1)
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System memory map specifications

Size Memory address System function

640 KB 00000000-0009FFFF Base memory

128 KB OOOAOO00-O00BFFFF Video memory

48 KB 000C0000-000CBFFF Video BIOS

160 KB 000C8000-000E7FFF Unused

64 KB OOOE8000-000FFFFF System BIOS

15 MB 00100000-00FFFFFF Extended memory

58 MB 04800000-07FFFFFF Super extended memory
58 MB 04800000-07FFFFFF Unused

2 MB 08000000-080FFFFF Video memory (direct access)
4GB 08200000-FFFEFFFF Unused

64 KB FFFFOOOO-FFFFFFFF System BIOS
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7 Screw listing

This section provides specification and reference information for the screws and screw locks used in the
computer. All screws and screw locks listed in this section are available in the Screw Kit, spare part number
448172-001, and the Display Screw Kit, spare part number 452309-001.

Phillips PM2.5%5.0 screw

mm ool

Color Quantity Length Thread Head diameter

Black 49 5.0 mm 2.5 mm 5.0 mm

Where used: 2 screws that secure the display bezel to the display assembly
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Where used:

(1) Two screws that secure the camera module to the display enclosure

(2) Eight screws that secure the display panel to the display enclosure
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Where used:

(1) Two screws that secure the WLAN module to the system board
(2) One screw that secures the rear cover to the computer

(3) Two screws that secure the top cover to the computer
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Where used: 2 screws that secure the TV tuner module to the system board

Where used:
(1) Four screws that secure the keyboard to the computer

(2) Four screws that secure the top cover to the computer
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Where used: 2 screws that secure the top cover to the computer

Where used:

(1) Two screws that secure the audio/infrared board to the base enclosure
(2) One screw that secures the rear USB board to the base enclosure

(3) Two screws that secure the front USB board to the base enclosure

(4) One screw that secures the video connector board to the base enclosure
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Black Phillips PM2.0x5.0 captive screw

- ® [m
mm oot

Color Quantity Length Thread Head diameter

Black 11 5.0 mm 2.0 mm 4.5 mm

Where used:
(1) Six captive screws (secured by Cclips) that secure the hard drive bay cover to the computer

(2) One captive screw (secured by a Clip) that secure the WLAN module compartment cover to the
computer

(3) Two captive screws (secured by C-clips) that secure the memory module compartment cover to the
computer

(4) Two captive screws (secured by C-clips) that secure the TV tuner module compartment cover to the
computer
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Phillips PM2.5x12.0 captive screw

Color Quantity Length Thread Head diameter

Silver 2 12.0 mm 2.5 mm 5.0 mm

Where used: 2 captive screws (secured by Cclips) that secure the hard drives to the computer
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Phillips PM3.0x4.0 screw

-® [m

mm it todinnnl

Color Quantity Length Thread Head diameter
Silver 8 4.0 mm 3.0 mm 5.0 mm
1 e, ~
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Where used: 8 screws that secure the hard drive brackets to the two hard drives
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Phillips PM2.5x8.0 screw

®  fjm

mm Lotohotndonl

Color Quantity Length Thread Head diameter

Black 26 8.0 mm 2.5 mm 5.0 mm

Where used:
(1) One screw that secures the optical drive to the computer
(2) Three screws that secure the keyboard to the computer

(3) Seven screws that secure the rear cover to the computer
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Where used: 10 screws that secure the top cover to the computer

I
I
I
I
I
I
|

Where used: 2 screws that secure the processor fan to the base enclosure
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Phillips PM2.0x3.0 screw

=® [p

mm Lol

Color Quantity Length Thread

Head diameter

Silver 2 3.0 mm 2.0 mm

4.5 mm

Ty

Where used: 2 screws that secure the optical drive bracket to the optical drive
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Phillips PM3.0x8.0 screw

=@  [mm
mm Lottt

Color Quantity Length Thread Head diameter

Black 16 8.0 mm 3.0 mm 5.0 mm

Where used: 6 screws that secure the display assembly to the computer
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Where used: 6 screws that secure the display assembly to the computer
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Phillips PM2.5x4.0 screw

-® [
mm Lot ol

Color Quantity Length Thread Head diameter

Black 8 4.0 mm 2.5 mm 5.0 mm

Where used:
(1) Four screws that secure the system board to the base enclosure

(2) Two screws that secure the audio connector board to the base enclosure
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Where used: 2 screws that secure the video board to the system board

Phillips PM3.0x12.0 screw

=@ [

mm bbbt

Color Quantity Length Thread Head diameter

Black 4 12.0 mm 3.0 mm 5.0 mm

Where used: 4 screws that secure the rear cover to the computer
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Phillips 2.5%3.0 broad-head screw

E |||||||||||

Color Quantity Length Thread Head diameter

Black 4 3.0 mm 2.5 mm 7.0 mm

Where used: 4 screws that secure the rear cover to the computer
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Phillips PM2.5x11.0 screw

: Ty

Color Quantity Length Thread Head diameter
Black 2 11.0 mm 2.5 mm 5.0 mm
T
I
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Where used: 2 screws that secure the top cover to the computer
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Silver Phillips PM2.0x4.0 screw

=@ [
onnmnmmm

Color Quantity Length Thread Head diameter

111}

Silver 6 4.0 mm 2.0 mm 4.5 mm

Where used:
(1) Two screws that secure the fingerprint reader board to the top cover

(2) Two screws that secure the TouchPad on/off board to the top cover
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Where used: 2 screws that secure the Bluetooth module to the base enclosure
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Slotted SM1.5%9.0 shoulder screw

=0 Q=
T

Color Quantity Length Thread Head diameter

Silver 2 9.0 mm 1.5 mm 1.5 mm

Where used: 2 screws that secure the system board to the base enclosure
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Phillips PM2.5x13.0 captive screw

mr%muumllunl

Color Quantity Length Thread Head diameter

Silver 1 13.0 mm 2.5 mm 5.0 mm

Where used: One captive screw (secured inside the video heat sink) that secures the system board and
video board heat sink to the base enlcosure
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Silver Phillips PM2.0x5.0 captive screw

- @ [m
mm [l

Color Quantity Length Thread Head diameter

Silver 7 5.0 mm 2.0 mm 4.5 mm

Where used:
(1) Three captive screws (secured by Clips) that secure the processor heat sink to the system board

(2) Four captive screws (secured by C-clips) that secure the video board heat sink to the system board
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Phillips PM2.5x8.0 captive screw

m%%mmﬂmlnnl

Color Quantity Length Thread Head diameter

Silver 2 8.0 mm 2.5 mm 5.0 mm
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Where used: 2 captive screws (secured inside the video board heat sink) that secure the video board
heat sink to the system board

130 Chapter 7 Screw listing



Black Phillips PM2.0x4.0 screw

=@ [
mm it

Color Quantity Length Thread Head diameter

Black 3 4.0 mm 2.0 mm 4.5 mm

Where used: 3 screws that secure the video board fan to the video board heat sink
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8 Backup and Recovery

Recovering system information

Tools provided by the operating system and Recovery Manager software are designed to help you with
the following tasks for safeguarding your information and restoring it in case of a system failure:

Backing up your information regularly to protect your important system files.

Making a set of recovery discs (Recovery Manager software feature). Recovery discs are used to
start up (boot) your computer and restore the operating system and software programs to factory
seftings in case of system failure or instability.

Creating system restore points (operating system feature). System restore points allow you to reverse
undesirable changes to your computer by restoring the computer to an earlier state.

Recovering a program or driver (Recovery Manager software feature). This feature helps you reinstall
a program or driver without performing a full system recovery.

Performing a full system recovery (Recovery Manager software feature). With Recovery Manager,
you can recover your full factory image if you experience system failure or instability. Recovery
Manager works from a dedicated recovery partition on the hard drive or from recovery discs you
create.Back up your information regularly to protect your important system files.

Creating recovery discs

After setting up the computer for the first time, be sure to create a set of recovery discs of the full factory
image. The recovery discs are used to start up (boot) the computer and recover the operating system and
software to factory settings in case of system instability or failure.

B NOTE: Handle these discs carefully and keep them in a safe place. The software allows the creation of
only one set of recovery discs.

Note the following guidelines before creating recovery discs:

You will need high quality CD-R, DVD-R, DVD-R with double-layer support, DVD+R, or DVD+R with
double-layer support discs (purchased separately).

B NOTE: Read-write discs, such as CD-RW, DVD + RW, and DVD+RW double-layer discs, are not

compatible with the Recovery Manager software.

The computer must be connected to AC power during this process.

Only one set of recovery discs can be created per computer.
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e Number each disc before inserting it into the computer optical drive.

e If necessary, you can exit the program before you have finished creating the recovery discs. The next
time you open Recovery Manager, you will be prompted to continue the disc creation process.

To create a set of recovery discs:
1. Select Start > All Programs > Recovery Manager > Recovery Manager.
Recovery Manager opens.

2. Click Advanced Options.

B NOTE: If you are operating the computer on battery power, you will be prompted to connect to
AC power before you can go to the next step.

3. Click Recovery disc creation, and then click Next.

4. Follow the on-screen instructions.

Backing up your information

When to back up

e  On a regularly scheduled basis

B’ NOTE: Set reminders to back up your information periodically.

e  Before the computer is repaired or restored

e Before you add or modity hardware or software
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Back up suggestions

Create a set of recovery discs using Recovery Manager.

Create system restore points using the Windows System Restore feature, and periodically copy them
to disc.

Store personal files in the Documents folder and back up these folders periodically.
Back up templates stored in their associated programs.

Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your settings.
The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document follow these steps:
a. Display the screen.
b. Copy the screen:

To copy only the active screen, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, and then select Edit > Paste.

Using system restore points

When you back up your system, you are creating a system restore point. A system restore point allows
you fo save and name a snapshot of your hard drive at a specific point in time. You can then recover
back to that point if you want to reverse subsequent changes made to your system.

B NOTE: Recovering to an earlier restore point does not affect data files saved or e-mails created since
the last restore point.

You also can create additional restore points to provide increased protection for your system files and
settings.

When to create restore points

Before you add or extensively modity software or hardware

Periodically, whenever the system is performing optimally

B NOTE: If you revert to a restore point and then change your mind, you can reverse the restoration.

Create a system restore point

Select Start > Control Panel > System and Maintenance > System.

In the left pane, click System protection.

Click the System Protection tab.

Under Automatic restore points, select the disk for which you want to create a restore point.

Click Create.
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The System Protection window opens.

6. Follow the on-screen instructions.
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Restore to a previous date and time

To revert to a restore point (created at a previous date and time), when the computer was functioning
optimally, follow these steps:

1. Select Start > Control Panel > System and Maintenance > System.
2. Inthe left pane, click System protection.
3. Click the System Protection tab.
4. Click the System Restore button, and then click Next.
The System Restore window opens.

5. Follow the on-screen instructions.
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Performing a recovery

Recovery Manager software allows you to repair or restore the system if you experience system failure or
instability. Recovery Manager works from recovery discs that you create or from a dedicated recovery
partition on the hard drive.

NOTE: Windows has its own built-in repair features, such as System Restore and driver roll-back
capabilities. If you have not already tried these features, try them before using Recovery Manager.

NOTE: Recovery Manager recovers only software that was preinstalled at the factory. Software not
provided with this computer must be downloaded from the manufacturer's Web site or reinstalled from
the disc provided by the manufacturer.

Recovering from the recovery discs

To restore the system from the recovery discs:
1. Back up all personal files.
2. Insert the first recovery disc into the optical drive and restart the computer.

3. Follow the on-screen instructions.

Recovering from the partition on the hard drive

You can perform a recovery from the partition on the hard drive from either the Start button or f11.
To restore the system from the partition, follow these steps:
1. Access Recovery Manager in either of the following ways:
e  Select Start > All Programs > Recovery Manager > Recovery Manager.
—or-

e  Restart the computer and press {11 while the “Press <F11> for recovery” message is displayed
on the screen. Then select Recovery Manager.

Recovery Manager opens.
2. Click Advanced Options.
3. Click System recovery, and then click Next.

4. Follow the on-screen instructions.
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9 Connector pin assignments

Audio-out (headphone)

Pin Signal

1 Audio out, left channel
2 Audio out, right channel
3 Ground

Pin Signal
1 Audio signal in
2 Audio signal in
3 Ground
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External monitor

®OO00®

®000 W

©000G

Pin Signal

1 Red analog

2 Green analog
3 Blue analog

4 Not connected
5 Ground

6 Ground analog
7 Ground analog
8 Ground analog
9 +5VDC

10 Ground

11 Monitor detect
12 DDC 2B data
13 Horizontal sync
14 Vertical sync
15 DDC 2B clock
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RJ-45 (network)

LT

12345678
Pin Signal
1 Transmit +
2 Transmit -
3 Receive +
4 Unused
5 Unused
6 Receive -
7 Unused
8 Unused
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Universal Serial Bus

1 2 3 4

Pin Signal
1 +5VDC
2 Data -
3 Data +
4 Ground
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10 Power cord set requirements

The wide range input feature of the computer permits it o operate from any line voltage from 100 to 120

volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the country
or region where the equipment is purchased.

Power cord sets for use in other countries or regions must meet the requirements of the country or region
where the computer is used.

Requirements for all countries or regions

The requirements listed below are applicable to all countries or regions:

The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

All power cord sets must be approved by an acceptable accredited agency responsible for evaluation
in the country or region where the power cord set will be used.

The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage rating
of 125 or 250 V AC, as required by each country or region’s power system.

The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard
Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries or regions

Country or region Accredited agency Applicable note number
Australia EANSW 1
Austria OVE 1
Belgium CEBC 1
Canada CSA 2
Denmark DEMKO 1
Finland FIMKO 1
France UTE 1
Germany VDE 1
ltaly IMQ 1
Japan METI 3
South Korea EK 4
The Netherlands KEMA 1
Norway NEMKO 1
The People's Republic of China CCC 5
Sweden SEMKO 1
Switzerland SEV 1
Taiwan BSMI 4
The United Kingdom BSI 1
The United States uL 2
1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm? conductor size. Power cord set fittings (appliance coupler

and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding
type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm? conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

The flexible cord must be Type RVV, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler and
wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be
used.

The flexible cord must be Type VCTF, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler and
wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be
used.
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11 Recycling

Battery

When a battery has reached the end of its useful life, do not dispose of the battery in general household
waste. Follow the local laws and regulations in your area for computer battery disposal.

Display

/A WARNING! The backlight contains mercury. Caution must be exercised when removing and handling
the backlight to avoid damaging this component and causing exposure to the mercury.

A CAUTION: The procedures in this appendix can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the backlight.
Careful handling must be exercised when removing these components.

Ef NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly
that might require special handling at end-of-life. Disposal of mercury may be regulated because of
environmental considerations. For disposal or recycling information, contact your local authorities, or see
the Electronic Industries Alliance (EIA) Web site at http://www.eige.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

Q9 —-

EY NOTE: The procedures provided in this appendix are general disassembly instructions. Specific details,
such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from one
computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2. lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of the
display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

o

u
o\

13. Remove the backlight cover.

14. Turn the display panel rightside up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.

17. Remove the backlight frame from the display panel.

/A WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.
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18. Remove the backlight from the backlight frame.

19.
20.
21.
22,

Disconnect the display cable (1) from the LCD panel.

Remove the screws (2) that secure the LCD panel to the display rear panel.

Release the LCD panel (3) from the display rear panel.

Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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